
1

Безплатен софтуер за композиране и нотиране на музика

Retrieved from http://musescore.org on Пон., 02/18/2013

Ръководство

Това ръководство е за MuseScore версия 0.9.4 и нагоре. За да помогнете
с подобряването или с превод на ръководството, пишете във MuseScore
documentation forum и кандидатствайте за участие в ръководството.

http:##musescore.org#bg
http:##www.musescore.org#forum#8
http:##www.musescore.org#forum#8
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глава 1

Начало

В тази глава ще намерите помощ относно инсталацията и стартиране на
MuseScore за първи път. Тук също ще видите как да създадете нова
партитура.

Инсталация
MuseScore работи на различни операционни системи, включително
Windows, Mac OS, и Linux.

Windows
Можете да намерите инсталатор за Windows от Изтегляне в сайта на
MuseScore. Цъкнете връзката, за да започне тегленето. Вашият
интернет браузър ще потвърди, че искате да изтеглите файла. Цъкнете
"Save File" (Запиши).

Като свърши тегленето, цъкнете два пъти на файла, за да започне
инсталацията. Windows може да покаже съобщение за сигурност и да
иска потвърждение за изпълняване на файла. Цъкнете "Run" (Изпълни),
за да продължите.

http:##musescore.org#en#download
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Инсталаторът препоръчва да затворите стартирани програми, преди да
продължите. След като го направите, цъкнете "Next", за да продължите.

Инсталационният помощник показва лицензионното споразумение,
което може да прегледате. Цъкнете "I Agree" (Съгласен съм), за да
продължите.

След това потвърдете местоположението, където MuseScore ще се
инсталира. Ако инсталирате по-нова версия на MuseScore, но искате да
запазите старата, ще трябва да промените адреса на папката. В
противен случай цъкнете "Next", за да продължите.

Следва потвърждение за името на папката, която ще се появи в списъка
с програми в Старт менюто. Цъкнете "Install" (Инсталиране), за да
продължите.

Изчакайте няколко минути докато завърши инсталацията и бъдат
приложени необходимите настройки. Като свърши, цъкнете "Finish", за
да затворите инсталатора. По желание, може да изтриете
инсталационния файл, който свалихте.

Стартиране на MuseScore
За да стартирате MuseScore цъкнете Start → All Programs → MuseScore →
MuseScore.
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След няколко секунди MuseScore ще отвори демо партитурата. Може
спокойно да експериментирате с демото, за да усетите програмата. След
това може да създадете собствена партитура.

За напреднали потребители: Безшумна, самостоятелна
инсталация
Можете да инсталирате MuseScore безшумно чрез следната команда
MuseScore-1.1.exe /S /D=C:\Program Files\MuseScore

Можете да деинсталирате чрез
cd C:\Program Files\MuseScore

Uninstall.exe /S

Mac OS X

Инсталиране
Ще намерите dmg файл за Mac на страница Изтегляне от уеб сайта на
MuseScore. Цъкнете връзката, за да започне тегленето. След
приключване на изтеглянето, dmg файлът автоматично се монтира на
работния плот като "MuseScore-0.9.6" и инсталатора се зарежда.

http:##musescore.org#bg#ръководство#създай-нова-партитура
http:##musescore.org#en#download
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Влачете иконата на MuseScore и я пуснете върху иконата на папка
Applications. Ако не сте администратор, Mac OS X ще поиска парола:
цъкнете "Authenticate" и въведете паролата, за да позволите на Mac OS X
да копира MuseScore в папка Applications.
Можете да стартирате MuseScore от Applications или SpotLight.

Премахване
Просто изтрийте MuseScore от папката Applications.

Linux
Вижте на страница Изтегляне за инструкции относно MuseScore на
Linux. Осигурени са пакети за Debian, Ubuntu, Fedora и PCLinuxOS. За
други дистрибуции ще трябва да компилирате програмата от кода. За
специфични за Fedora инструкции виж по-долу.

Fedora
Import the GPG key:

su

rpm --import http://prereleases.musescore.org/linux/Fedora/RPM-GPG-KEY-Seve

2. Идете на страница Изтегляне от сайта на MuseScore. Изтеглете
стабилната версия за Fedora, като изберете точния rpm пакет за
вашата архитектура

3. В зависимост от архитектурата, използвайте един от двата набора
команди, за да инсталирате MuseScore

за архитектура i386

su

yum localinstall musescore-0.9.4-1.fc10.i386.rpm

или за архитектура x86_64

su

yum localinstall musescore-0.9.4-1.fc10.x86_64.rpm

Ако имате проблеми със звука, вижте Fedora 11 and sound.

Създай нова партитура
От основното меню изберете Файл → Нов.... Отваря се помощник за нова
партитура.

Заглавие, композитор и друга информация

http:##musescore.org#en#download
http:##musescore.org#en#download
http:##www.musescore.org#en#node#3848#comment-9634
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Въведете заглавие, композитор или каквото и да е друго, както е
показано отгоре. Обърнете внимание на двете опции долу:

• Създай нова партитура от шаблон

• Създай нова партитура от чернова

Първата опция предлага готови партитури в следващия екран. Втората
опция дава избор на всички инструменти на следващия екран. Повече за
шаблоните по-долу, но засега изберете "Създай нова партитура от
чернова"

Цъкнете "Next" за да продължите.

Инструментални и гласови партии

Прозорецът с инструменти е разделен на две колони. От първата се
избира инструмент или вокал. Втората първоначално е празна, после ще
съдържа избраните инструменти за новата партитура.
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Инструментите са групирани в семейства. Цъкнете два пъти група, за да
се покажат инструментите в нея. Изберете инструмент и натиснете
"Добави". Избраният инструмент отива във втората колона. При
необходимост можете да добавите още инструменти.

Подредбата на инструментите във втората колона определя реда им в
партитурата. За да промените реда, цъкнете върху инструмент и
използвайте стрелките "Нагоре" или "Надолу" за преместване нагоре и
надолу. Като сте готови цъкнете "Next".

Арматура
Ако използвате последната версия на MuseScore помощникът ще пита за
тоналност. Изберете желаните арматурни знаци и цъкнете "Next".

Размер, ауфтакт и брой тактове

Задайте желаната размерност. Ако партитурата започва с ауфтакт,
сложете отметка на "Ауфтакт" и настройте реалния размер на първия
такт.

Ако знаете приблизително колко такта ще ви трябват можете да
зададете броя им тук. В противен случай може да добавяте или
премахвате тактове в последствие.

Цъкнете "Finish" за да създадете новата партитура.

Настройки след създаване на партитурата
Можете да променяте всякакви настройки, направени в помощника,
дори след започната работа по партитурата.

• За добавяне, триене или създаване на такт виж Работа с тактове

• За промяна на текст виж Редактиране на текст. Да добавите
липсващо заглавие (или друг текст) използвайте меню Създай → Текст
→ Заглавие (или друг текст)

http:##musescore.org#bg#ръководство#работа-с-тактове
http:##musescore.org#bg#ръководство#редактиране-на-текст
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• За да добавите, изтриете или промените редът на инструментите
използвайте меню Създай → Инструмент....

Виж още: Арматура, Размер, Ключове.

Шаблони
Първият екран от помощника за нова партитура има опция "Създаване
на партитура от шаблон" (виж Заглавие и друг текст по-горе, за
подробности). За да създадете партитура чрез този метод, изберете
опцията от шаблон и цъкнете "Next", за да продължите.

Следващият екран показва списък с шаблони. Изберете шаблон и
цъкнете "Next". Продължете, за да завършите помощника, както
обикновено.

Шаблоните са обикновени MuseScore файлове, съхранявани в папка
template. Може да създавате свои шаблони, като ги съхранявате като
MuseScore файлове в тази директория. В Windows папката template
обикновено се намира в C:\Program Files\MuseScore\templates. В Linux
вижте в /usr/share/mscore-xxx ако сте инсталирали от пакетния
мениджър. Ако сте компилирали mscore под Linux тогава вижте в
/usr/local/share/mscore-xxx. При Mac вижте в
/Applications/MuseScore.app/Contents/Resources/templates

http:##musescore.org#bg#ръководство#арматура
http:##musescore.org#bg#ръководство#размер
http:##musescore.org#bg#ръководство#ключове
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глава 2

Основи

Глава "Начало" по-горе упътваше за инсталацията и процеса на
създаване на нова партитура. Глава "Основи" дава поглед върху
MuseScore и описва основните методи за взаимодействие с партитурата.

Въвеждане на ноти
Нотите се въвеждат в режим Note entry mode. Първо изберете нота или
пауза за начална позиция. При въвеждане винаги се заместват
съществуващи ноти или паузи. Ако искате да вмъкнете раздел, първо
създайте нужния брой тактове на подходящото място, преди да добавите
ноти.

• N: Влиза в режим Note entry mode.

• Escape: Изход от Note entry mode.

Като влезете в Note entry mode трябва да изберете времетраене на
нотата, която ще въвеждате, като изберете стойност от нотната палитра
или със съответната клавишна комбинация.

Клавишните комбинации за избор на времетраене са:

• 1: 64-тина нота (hemidemisemiquaver)

• 2: 32-ина нота (demisemiquaver)

• 3: 16-тина нота (semiquaver)

• 4: Осмина нота (quaver)

• 5: Четвъртина нота (crotchet)

• 6: Половина нота (minim)

• 7: Цяла нота (semibreve)

• 8: Двойна цяла нота (breve)

http:##musescore.org#bg#ръководство#инсталация
http:##musescore.org#bg#ръководство#създай-нова-партитура
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• 9: Longa

• .: Точката променя избраната продължителност в такава нота с
точка

Ноти се въвеждат с клавиши: C D E F G A B C

0 (нула) поставя пауза: например C D 0 E. Забележете, че избраното
времетраене за нотите (четвъртина в случая), определя и това на
паузите (четвъртина пауза)

Имайте предвид, че във версия 0.9.6 и по-старите, Интервал създава пауза.
В новите версии на MuseScore Интервал започва възпроизвеждане.

При въвеждане MuseScore автоматично придвижва напред. Ако искате
да добавите нота към последно въведената, направете го, като държите
Shift и пишете нота: C D Shift+F Shift+A E F

За да създадете акорди с ноти с различно времетраене виж Гласове.

Ако искате да добавите точкувана нота, натиснете .. Например 5 . C 4 D E F
G A

За повишаване или понижаване на последно въведената нота с една
октава, използвайте следните клавишни комбинации:

• Ctrl+Up (Mac: ⌘+Up): Повишаване на тона с една октава.

• Ctrl+Down (Mac: ⌘+Down): Понижаване на тона с една октава.

Други команди за редактиране:

• x: Обръща байрачето на нотата.

• Shift+x: Премества главата на нотата от другата страна на байрачето.

MIDI клавиатура
Можете също да въвеждате тонове чрез MIDI клавиатура в MuseScore
версия 0.9.6 или по-нова.

1. Свържете MIDI клавиатурата към компютъра и я включете

http:##musescore.org#bg#ръководство#гласове
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2. Стартирайте MuseScore

3. Създайте нова партитура

4. Изберете паузата в първи такт за да зададете откъде ще започне
въвеждането

5. Натиснете N за режим на въвеждане

6. Изберете времетраене, например 5 за четвъртина нота (crotchet),
както е описано по-горе

7. Натиснете клавиш от MIDI клавиатурата и забележете как тонът се
добавя към партитурата

Бележка: MIDI клавиатурата вмъква по една нота или акорд
последователно. Този режим на въвеждане (наричан стъпково
въвеждане) е бърз и надежден. Някои софтуери се опитват да въвеждат в
реално време, където музикантът свири пасаж и програмата се опитва
да нотира. Често обаче резултатът е ненадежден, дори при изсвирване
от професионалист със скъп софтуер. Особено при компютърния хардуер
има проблем със закъснението - закъснение в смисъл времето, за което
сигнала стига до софтуера след натискане на клавиш на MIDI
клавиатурата - това прави почти невъзможно прецизното въвеждане.
MuseScore се фокусира над по-надеждни методи за нотиране.

Ако имате няколко MIDI устройства, свързани към компютъра, ще
трябва да кажете на MuseScore кое е MIDI клавиатурата. Ако използвате
версия 0.9.6 или по-нова идете в Edit → Preferences... (Mac: MuseScore →
Preferences...). В диалога за предпочитания цъкнете на I/O раздел и
изберете устройството в полето "Choose PortMidi input device".

Оцветяване на извън обхватните ноти
MuseScore оцветява ноти извън обхвата в жълто или червено във версия
0.9.5 или по-нова. Ноти над или под удобния за аматьор диапазон се
показват в жълто, а тези отвъд удобния за професионалист обхват са в
червено. Цветовете са информативни и се показват само на екрана, но
не се отпечатват. За да изключите цветовете във версия 0.9.6 и по-нова,
изберете Edit → Preferences... (Mac: MuseScore → Preferences...), цъкнете Note
Entry раздел, и размаркирайте "Color notes outside of usable pitch range".

Виж още
• Нотиране на ударни

Външни препратки
• Video tutorial: Note entry basics by Katie Wardrobe

Копиране и поставяне

http:##musescore.org#bg#ръководство#нотиране-на-ударни
http:##www.youtube.com#watch?v=ugzgezapbge
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Копирането-поставянето е полезен инструмент за повтаряща се музика
или за преместване на част от музиката с такт или два.

Копиране
1. Цъкнете първата нота от селекцията

2. Shift+цъкване върху последната нота. Син правоъгълник трябва да
покаже областта на селектиране.

3. От менюто изберете Редактиране → Копирай

Поставяне
1. Цъкнете нота или такт за да укажете къде да се поставят

елементите

2. От менюто изберете Редактиране → Постави

Редактиране
Много от елементите в партитурата могат да бъдат редактирани в режим
Редактиране :

• Двойно цъкване: Стартира режим Редактиране

• Escape: Излиза от режим Редактиране

Някои елементи имат ръкохватки в режим редактиране, които могат да
се преместват с мишката или с клавишни комбинации.

Легато в режим Редактиране:

Възможни клавишни комбинации:

• Left: Мести ръкохватката един интервал наляво

• Right: Мести ръкохватката един интервал надясно

• Up: Мести ръкохватката един интервал нагоре

• Down: Мести ръкохватката един интервал надолу

• Ctrl+Left (Mac: ⌘+Left): Мести ръкохватката 0.1 интервал наляво

• Ctrl+Right (Mac: ⌘+Right): Мести ръкохватката 0.1 интервал надясно

• Ctrl+Up (Mac: ⌘+Up): Мести ръкохватката 0.1 интервал нагоре

• Ctrl+Down (Mac: ⌘+Down): Мести ръкохватката 0.1 интервал надолу

http:##musescore.org#bg#ръководство#легато
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• Shift+Left: Мести избраната точка на ръкохватката наляво

• Shift+Right: Мести избраната точка на ръкохватката надясно

• Tab: Отива на следващата ръкохватка

Виж още: Text editing, Легато, Аколада, Линии

Работа с тактове

Добавяне
За да добавите такт в края, натиснете Ctrl+B (Mac: ⌘+B), или от менюто
изберете Create → Measures → Append Measure. За да добавите множество
тактове натиснете Ctrl+Shift+B (Mac: ⌘+Shift+B) или използвайте меню
Create → Measures → Append Measures....

Вмъкване
Първо изберете такт и натиснете Ins или използвайте меню Create →
Measures → Insert Measure за да вмъкнете празен такт пред избрания. За
множество тактове натиснете Ctrl+Ins (Mac: ⌘+Ins) или използвайте меню
Create → Measures → Insert Measures....

Изтриване
Изберете такт и натиснете Ctrl+Del (Mac: ⌘+Fn+Backspace).
В 0.9.5 и по-стари, е различно. Натиснете Ctrl (Mac: ⌘) и цъкнете на
празно място върху такт. Такта се маркира с пунктирана линия
указваща избрана "част от време". Натиснете Ctrl+Цък (Mac: ⌘+Click) за
разтягане на селекцията. Натискане на Del (Mac: Fn+Backspace) премахва
избраните тактове.

Свойства
За да редактирате свойствата на такт, цъкнете с дясно копче върху
празна част от него и изберете Measure Properties....

http:##musescore.org#en#handbook#text-editing
http:##musescore.org#bg#ръководство#легато
http:##musescore.org#bg#ръководство#аколада
http:##musescore.org#bg#ръководство#линии
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Петолиния
Свойството Visible позволява скриване и показване на нотите и линиите
от петолинието за съответния такт. Свойството Stemless позволява да се
крият опашките на нотите за такта. Ноти, имащи по принцип опашки,
като половини (minums) и четвъртини (crotchets), ще бъдат показвани
само главите им при избрана опция.

Времетраене
Номиналното времетраене е това, което се показва в партитурата.
Можете да промените Действителното времетраене на такта на
каквото и да е, без значение какво е изписано. Обикновено номиналното
и действителното са еднакви. Въпреки това може да има непълен такт
(ауфтакт), който да трае по-малко.

На долната фигура тактът с четвъртината нота (crochet) има номинално
времетраене 4/4, но действителното е 1/4. Тактовете в средата имат
номинално и действително времетраене 4/4. Заключителния такт
съдържа само половина с точка (точкуван minim) и действителното му
времетраене е 3/4.

Неправилни
"Неправилен" такт не се брои в номерацията. Обикновено ауфтакт се
отбелязва като "неправилен". Ако използвате версия 0.9.4 или по-стара и
отбележите такт като неправилен, тогава ще се наложи да запишете и
заредите на ново партитурата, за да се актуализира броят на тактовете.

Добави към броя на тактовете
Можете да използвате опцията "add to measure no." за да повлияете на 
номерацията на тактовете. Може да въведете положителна или 
отрицателна стойност. Имайте предвид, че това влияе на следващите 
тактове. Стойност "-1" има същия ефект като да отбележите такт като
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неправилен.

Разтягане на полето
Можете да увеличавате или намалявате хоризонталното разстояние
между нотите с тази опция.

Брой повторения
Ако даден такт е на края на повторение, трябва да зададете колко пъти
се свири повторението.

Прекъсване на многотактови паузи
Това свойство разделя многотактова пауза в съответния такт. Трябва да
проверите тази опция преди да включите опцията "Create multi-measure
rests" в Style → Edit General Style.

Версия 0.9.6 и по-нова автоматично прекъсва тактовете при такива
паузи на важни места като rehearsal marks, промяна на размерност,
двойни тактови черти и т.н.

Номериране
MuseScore автоматично номерира първия такт на всяка система, но има
възможност за повече опции. От главното меню изберете Style → Edit Style.
В лявото поле изберете "Numbers". В долната част на дясното поле се
намира раздел "Measure Numbers" ("Bar Numbers").

Сложете отметка на "Measure Numbers" ("Bar Numbers"), за да включите
автоматично номериране на тактовете.
Отбележете "show first" ако искате номер на първия такт.
Отбележете "all staffs" ако искате номера на всички петолиния, в
противен случай само на най-горното петолиние от системата ще има
номерация.
Изберете да се показват номера на всяка система ("every system"), която
номерира първия такт на всяка линия или да показва номерация през
интервал ("interval") и задайте интервала. Например интервал от 1 ще
номерира всеки такт; интервал от 5 ще номерира всеки пети такт.

Палитра
Може да показвате и скривате палитрата от менюто Display → Palette.

Може да влачите и пускате символи от палитрата върху елементи от
партитурата.

Двойно цъкване върху символ от палитрата е еквивалентно на
завлачване на символа върху всички избрани елементи в партитурата.

http:##musescore.org#bg#ръководство#повторение
http:##musescore.org#bg#ръководство#тактови-паузи
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Например лесно може да добавите tenuto на няколко ноти
едновременно:

1. Изберете ноти

2. Цъкнете два пъти върху символа tenuto в палитрата
Articulations/Ornaments

Undo и redo
MuseScore няма ограничение за undo/redo.

Стандартните комбинации са:

• Undo Ctrl+Z (Mac: ⌘+Z)

• Redo Ctrl+Shift+Z или Ctrl+Y (Mac: ⌘+Shift+Z)

Или използвайте бутоните в лентата с инструменти:

Файлов формат
MuseScore поддържа голямо разнообразие от файлови формати, които ви
позволяват да споделяте и публикувате партитури във формата, който е
най-подходящ за вас. Можете да внасяте файлове чрез File → Open... и да
експортирате чрез File → Save As.... В допълнение на детайлно описаните
долу формати, можете да записвате и споделяте ваши партитури в
Интернет на MuseScore.com, както е описано в следващия раздел.

MuseScore собствен формат

Компресиран MuseScore формат (*.mscz)

MSCZ е стандартния MuseScore файлов формат, препоръчван за
повечето потребители. Записът на партитура в този формат заема
много малко място, но запазва всичката нужна информация.
Форматът е версия на .mscx файлове, но със ZIP-компресия и
включва изображения.

MuseScore формат (*.mscx)

MSCX е не-компресирана версия на форматът на MuseScore 
използван във версия 0.9.5 и по-нови. Партитура записана в този 
формат не губи никаква информация, освен изображенията и се

http:##musescore.com?utm_source=handbook
http:##musescore.org#en#handbook#share-scores-online
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препоръчва ако искате ръчно да редактирате файла с текстов
редактор. Предишните версии на MuseScore използваха MSC
разширение. Обаче MSC разширението се дублира с разширение,
използвано от Microsoft Windows и се блокира от някои email
доставчици. Новото MSCX разширение замества старото MSC поради
гореспоменатите проблеми.

Забележка: MuseScore не вгражда шрифтове във файла. Ако искате да
споделяте MuseScore файлове с други, изберете шрифт за текста, който
другите имат инсталиран. Когато компютъра няма използваните
шрифтове във файла, MuseScore използва резервен вместо него. Разбира
се заместващият ще изглежда различно.

MuseScore резервни копия

Резервни копия на MuseScore (.*.mscz, or .*.mscx,)

Резервните копия се създават и записват автоматично в същата
папка, като нормалния файл. Резервният файл добавя точка пред
името (.) и запетая (,) в края (например ако нормалният ви файл се
казва "untitled.mscz", тогава резервното копие ще се казва
".untitled.mscz,"). Резервното копие съдържа предишната записана
версия на MuseScore файла и може да бъде важен, в случай че
оригиналният файл се повреди или искате да погледнете в малко
по-стар вариант на партитурата си. За да отворите резервно копие на
MuseScore трябва да преименувате файлът, като премахнете точката
и запетаята. Тъй като е записан в същата директория като работният
ви файл, ще е необходимо да му зададете уникално име (например
може да преименувате ".untitled.mscz," на
"untitled-backup1.mscz").

Ако използвате Linux трябва да покажете скритите файлове, за да
видите резервните копия на MuseScore.

Печат и четене (Експорт само)

PDF (*.pdf)

Portable Document Format (PDF) е идеален за споделяне на музика с
хора, които няма да я редактират. Повечето потребители имат
инсталиран PDF четец на компютъра си, затова няма нужда от
инсталация на друг софтуер за да прегледат нотите.

PostScript (*.ps)

PostScript (PS) е популярен формат в професионалния предпечат.

PNG (*.png)

Portable Network Graphics (PNG) е растерен формат за изображения, 
широко поддържан от софтуер за Windows, Mac OS и Linux. Форматът
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за изображения е особено популярен в Интернет. Партитури с много
страници се експортират PNG файл за всяка страница. MuseScore
създава изображения, така както биха изглеждали на разпечатка.
Ако искате да създадете изображение, показващо елементи на
екрана, като рамки, невидими ноти, цветните извън-грифови ноти,
отидете на Edit → Preferences... (Mac: MuseScore → Preferences...) цъкнете
раздел Export и маркирайте "Screen shot function".

SVG (*.svg)

Scalable Vector Graphics (SVG) могат да се отворят с повечето
Интернет браузъри (с изключение на Internet Explorer) и повечето
програми за векторна графика. Само че повечето SVG програми не
поддържат вградени шрифтове, затова трябва да е инсталиран
подходящият шрифт на MuseScore, за да се виждат файловете
правилно.

Слушане (Експорт само)

WAV Audio (*.wav)

WAV (Waveform Audio Format) е некомпресиран формат за звук,
разработен от Microsoft и IBM, но широко поддържан от програми за
Windows, Mac OS, и Linux. Идеален формат за създаване на дискове,
тъй като няма загуби на качеството при запис. Но пък големия
размер на файловете го прави неподходящ за споделяне по
електронна поща или интернет. Възможността за експорт в този
формат е налична от версия 0.9.5 нататък.

FLAC Audio (*.flac)

Free Lossless Audio Codec (FLAC) е компресиран аудио формат. FLAC
файловете са приблизително наполовина големината на
некомпресираните и същото добро качество. Windows и Mac OS не
поддъжат FLAC, но програми като VLC media player могат да
просвирват FLAC файлове на всяка операционна система. Запис в
този формат е възможен от версия 0.9.5 нататък.

Ogg Vorbis (*.ogg)

Ogg Vorbis е замислен като свободен заместител на популярния MP3
аудио формат. Както MP3, Ogg Vorbis файловете са сравнително
малки (често около една десета от некомпресирания), но със
известни загуби на качеството. Windows и Mac OS не поддържат Ogg
Vorbis. Но програми като VLC media player и Firefox 3.5 или по-нов
могат да възпроизвеждат Ogg файлове на всяка операционна
система. Запис в този формат е възможен от версия 0.9.5 нататък.

Споделяне с друг музикален софтуер

http:##www.videolan.org#vlc#
http:##www.videolan.org#vlc#
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MusicXML (*.xml)

MusicXML е универсален стандарт за нотопис и може да се ползва от
повечето налични нотописни програми, включително Sibelius, Finale
и над 100 други. Препоръчителен формат за споделяне на ноти
между различни програми.

Компресиран MusicXML (*.mxl)

Компресирания MusicXML създава по-малки файлове в сравнение със
стандартния MusicXML. Компресирания MusicXML е по-нов стандарт
и не е толкова широко поддържан от други нотиращи програми
засега.

MIDI (*.mid, *.midi, *.kar)

Musical Instrument Digital Interface (MIDI) е широко поддържан от
секвенсери и нотиращи програми формат. Все пак MIDI файловете са
създадени за възпроизвеждане, а не за писане, затова те не
съдържат информация за форматиране, изписване на тонове,
гласове, орнаментика, артикулация, повторения или тоналност
измежду другите работи. За споделяне на партитури с друг
нотопишещ софтуер използвайте MusicXML. Ако ви интересува само
възпроизвеждането, тогава използвайте MIDI.

LilyPond (*.ly) (Само изнасяне)

LY файлове се отварят с безплатния нотописец Lilypond . Обаче
записът в LilyPond е незавършен и експериментален в настоящите
версии на MuseScore.

MuseData (*.md) (Само внасяне)

MuseData е формат разработен от Уолтър Б. Хюлет, започвайки през
1983 като ранно средство за споделяне на ноти между софтуери.
След това бе засенчен от MusicXML, но няколко хиляди партитури са
все още налични в Интернет в този формат.

Capella (*.cap) (Само внасяне)

CAP файлове се създават от нотописеца Capella. MuseScore внася
тези файлове сравнително точно.

Bagpipe Music Writer (*.bww) (Само внасяне)

BWW файлове се създават от нотописеца Bagpipe Music Writer.
Функцията за внасяне е налична във версия 1.0 и по-нова.

BB (*.mgu, *.sgu) (Само внасяне)

http:##www.recordare.com#xml.html
http:##lilypond.org
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BB файлове се създават от музикално-аранжиращия софтуер
Band-in-a-Box. MuseScore включва експериментална поддръжка на
внасяне на ВВ.

Overture (*.ove) (Само внасяне)

OVE файлове се създават от нотописеца Overture. Тази
експериментална опция за внасяне е налично от версия 0.9.6
нататък.
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глава 3

Нотиране

В предната глава "Основи" научихте как се въвеждат ноти и работа
спалитрата. Глава "Нотиране" описва различните видове нотация
по-детайлно, включително и по-напреднали начини за нотиране.

Хроматични знаци
Хроматичните знаци могат да се поставят или променят, като се влачи
знак от палитрата върху нота в партитурата.

Ако просто искате да промените височината на тона можете да изберете
нотата и да натиснете:

• Up: Повишава нотата с половин тон (склонност към диези).

• Down: Понижава нотата с половин тон (склонност към бемоли).

• Ctrl+Up: Повишава нотата с една октава.

• Ctrl+Down: Понижава нотата с една октава.

Във версия 0.9.6 или по-нова можете да промените съществуващ знак в
предупредителен (затворен в скоби). Влачете скобите от палитрата
върху съществуващият знак (не върху нотата). За да премахнете скобите,
изберете хроматичен знак и натиснете Delete.

http:##musescore.org#bg#ръководство#въвеждане-на-ноти
http:##musescore.org#bg#ръководство#палитра
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Ако в последствие промените тона със стрелките, ръчните настройки се
премахват.

Функцията от меню Notes → Pitch spell опитва да познае правилните
хроматични знаци за цялата партитура.

Арпежи и Глисандо
Арпежите се означават, като влачите символ от палитра Арпежи и
Глисандо върху нота или акорд.

За да промените дължината на арпежа цъкнете два пъти символа и
местите ръкохватките нагоре или надолу.

Външни препратки
Глисандо се поставя чрез влачене на глисандо символ от палитра
Арпежи и Глисандо върху първата от две последователни ноти на едно и
също петолиние.

За промяна или изтриване на текст от глисандото, цъкнете с дясно копче
върху него и изберете "Свойства" от менюто. Ако няма достатъчно място
между нотите, MuseScore няма да покаже текста.

• Arpeggio at en.wikipedia.org

Тактови черти

Промяна на вида
Тактовите черти се променят, като се влачи даден вид от палитрата
върху черта в партитурата.

http:##en.wikipedia.org#wiki#arpeggio
http:##en.wikipedia.org
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За да скриете тактова черта нацяло цъкнете с дясно копче линията и
изберете Set Invisible.

Създаване на grand staff
За да разпънете тактовата черта на няколко петолиния цъкнете два пъти
върху нея, за да я редактирате (виж Редактиране).

Цъкнете и влачете синьото квадратче надолу до следващото петолиние.
Визуализацията на всички черти се обновява като излезете от
Редактиране.

Виж още: Работа с тактове

Ребра
Ребрата се задават автоматично, но това може да се промени ръчно.
Влачете символ от палитрата с ребрата върху нота, за да промените
изписването им.

Можете първо да изберете нота и после да цъкнете два пъти подходящ
символ от палитрата.

Започва ребрата от тази нота.
Да не завършва ребро в тази нота.
Не свързвай нотата с ребра.

http:##musescore.org#bg#ръководство#редактиране
http:##musescore.org#bg#ръководство#работа-с-тактове
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 'A'   = (обратно към) Автоматичен режим: режимът, който MuseScore
избира при въвеждане на ноти, в зависимост от текущото времетраене.

За да промените ъгълът или разстоянието на ребрата към нотите (пр.
дължината на опашките), цъкнете два пъти реброто за режим
редактиране, с избрана дясна ръкохватка. Стрелките Нагоре/Надолу
вече ще изменят ъгъла. Избирайки лявата ръкохватка и използвайки
стрелки Нагоре/Надолу ще удължава/скъсява опашките. Натиснете Esc,
за да излезете от режим редактиране, когато сте готови с промените.

За да преместите ребра под нотите вместо над тях или обратно, обърнете
посоката на опашките чрез бутона преди гласовия индикатор, който
показва нота с две опашки (отгоре и отдолу) или използвайте клавиш X.

Виж още
• Групиране на ноти между петолиния

• Edit Mode

• Note Entry

Attachment Размер
beam-palette.png 2.58 KB

Аколада

Изтриване
Изберете скобата и натиснете Del

Добавяне
Влачете скоба от наличните в палитрата в празното поле на първия такт
от система.

Промяна
Влачете символ от палитра аколада върху съществуваща скоба в
партитурата.

Редактиране
Цъкнете два пъти скоба за да влезете в режим редактиране. В режим
редактиране можете да разтегляте скобата за да обхване други
петолиния.

Хоризонтално отместване

http:##musescore.org#bg#ръководство#редактиране
http:##musescore.org#bg#ръководство#групиране-на-ноти-между-петолиния
http:##musescore.org#en#handbook#edit-mode
http:##musescore.org#en#handbook#note-entry
http:##musescore.org#sites#musescore.org#files#beam-palette_0.png
http:##musescore.org#bg#ръководство#редактиране
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Ако е необходимо да преместите още наляво или надясно, цъкнете
скобата два пъти, за да влезете в режим редактиране и натиснете
Shift+Left or Shift+Right.

Цезура
За да поставите символ за цезура, влачете го от палитрата върху нота от
партитурата. Цезурата се поставя след нотата. Във версия 0.9.5 и
по-стара, цезурата се показва преди нотата, върху която се влачена.

Цезура в партитурата:

Caesura (неформално наричани още релси) действат по същия начин и
са налични от версия 0.9.6 нататък.

Ключове
Ключовете се създават или променят чрез влачене на символ от
палитрата с ключове към такт или друг ключ. Използвайте F9 (Mac:
⌥+⌘+K) за показване на палитрата отстрани.

http:##musescore.org#bg#ръководство#палитра
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Добавяне
Влачете ключ от палитрата върху празна част от такт. Това създава
ключ в началото на такта. Влачете ключ върху дадена нота, за да
създадете ключ в средата на такта. Ако такта не е първи в петолинието,
ключът се изобразява по-малък.

Премахване
Изберете ключ и натиснете Del.

Имайте предвид, че промяната на ключ не променя тоновете на никоя
нота. Вместо това нотите се преместват, за да се запази тоналността.

Нотиране на ударни
Примерно нотиране на ударни:

Нотирането на комплект ударни инструменти често включва обърнати
нагоре и надолу ноти, изсвирени едновременно. Ако не сте запознати с
въвеждането на няколко гласа на едно петолиние, вижте Гласове за
справка. Вижте по-надолу за инструкции относно нотиране на ударни.

MIDI клавиатура
Най-лесния начин за добавяне на ударни в партитурата е чрез MIDI
клавиатура. Повечето MIDI клавиатури имат ударни символи над всеки
клавиш. Ако натиснете клавиша за фус, MuseScore ще добави
правилната нота в партитурата. MuseScore автоматично наглася
опашките и главите на нотите.

Мишка
Нотирането на безтонови перкусии е различно, отколкото при другите
инструменти, затова ето няколко специални стъпки:

1. Изберете нота или пауза от партитурата. Имайте предвид, че
палитрата с ударни ще е празна, докато не завършите тази стъпка

2. Натиснете "N" за да започнете въвеждането

3. Изберете продължителност от лентата с инструменти

4. Изберете тип нота (като каса, сол барабан) от палитра ударни

5. Цъкнете върху петолинието с ударни, за да добавите нотата

http:##musescore.org#bg#ръководство#гласове
http:##musescore.org#bg#ръководство#палитра
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Външни препратки
• Drum Parts [video]

Форшлаг

Нотиране
Краткият форшлаг (Acciaccatura) изглежда като малки ноти
пресечени през байрачето. Дългият форшлаг (Appoggiatura) няма
пресичаща линийка. И двата вида се разполагат пред основната нота.

Инструкции
Създайте форшлаг като влачите символът от палитра форшлаг (Във
версия 0.9.5 и по-стара палитрата се казва просто Ноти) върху нормална
нота от партитурата.

Ако искате да промените продължителността на вече създаден форшлаг,
маркирайте го и изберете продължителност от лентата с инструменти
или с клавиши 1 ... 9 (виж въвеждане на ноти).

Външни препратки
• Grace note или Форшлаг, Appoggiatura и Acciaccatura, в

en.wikipedia.org

Динамика
Знаците за динамика са линейни обекти. За да създадете знак първо
изберете нота за начална позиция.

• H: Създава кресчендо

• Shift+H: Създава декресчендо

Можете да създадете кресчендо/декресчендо влачейки символът от
палитрата върху глава на нота.

1. H създава кресчендо:

http:##www.youtube.com#watch?v=kfj7v5s4akw
http:##musescore.org#bg#ръководство#палитра
http:##musescore.org#bg#ръководство#въвеждане-на-ноти
http:##en.wikipedia.org#wiki#grace_note
http:##bg.wikipedia.org#wiki#%d0%a4%d0%be%d1%80%d1%88%d0%bb%d0%b0%d0%b3
http:##en.wikipedia.org#wiki#appoggiatura
http:##en.wikipedia.org
http:##musescore.org#bg#ръководство#линии
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2. Двойно цъкване превключва в режим редактиране:

3. Shift+Right мести крайната позиция:

4. Right мести крайната точка:

Арматура
Арматурните знаци се добавят или променят, като влачите знак от
палитрата върху такт или съществуващи арматурни знаци.

F9 отваря палитрата.

Промяна
Влачете знак от палитрата върху знак от партитурата. Може също да
влачите знак от партитурата върху друг знак в партитурата като
използвате Shift+ляв бутон+Влачене.

Добавяне
Влачете знак от палитрата върху празна част от такт. Добавя се знак в
началото на такта.

Премахване
Изберете арматурен знак и натиснете Del.

Линии

http:##musescore.org#bg#ръководство#редактиране
http:##musescore.org#bg#ръководство#палитра
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Палитрата с лини както и другите палитри работи чрез влачене.
Влачете елемент от палитрата с мишката върху партитурата.

Промяна на дължината
Ако промените дължината на линията с мишката, "ръкохватките"
(нотите и тактовете, които обхваща) не се променят. За това следния
метод е препоръчителен за нагласяне на началото и края на линията.

1. Ако сте в режим note entry mode натиснете N за да излезете

2. Цъкнете два пъти линията, която ще променяте

3. Местете ръкохватките чрез следните комбинации

• Shift+Right за преместване на краищата надясно с една нота (или
такт)

• Shift+Left за преместване на краищата наляво с една нота (или
такт)

4. Ако трябва да промените дължината само визуално без да се
засегне обхватът от ноти или тактове, тогава използвайте

• Right за преместване на ръкохватката надясно с една единица

• Left за преместване на ръкохватката наляво с една единица

Виж още: Hairpin, Volta (1st and 2nd endings)

Тактови паузи

Целотактова пауза

Когато целия такт е празен се използва пауза на цял такт.

За да създадете целотактова пауза изберете такт и натиснете Del. Всички
ноти и паузи на този такт се заменят с една целотактова пауза.

Многотактова пауза

http:##musescore.org#bg#ръководство#палитра
http:##musescore.org#nl#handboek#hairpin
http:##musescore.org#cs#volta
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Многотактовите паузи указват продължителна тишина за инструмент и
често се използват в ансамбълна музика.

Инструкции

1. От менюто изберете Style → Edit General Style (Във версия 0.9.5 и
по-стари е в Style → Edit Style)

2. Цъкнете раздел "Score" ако вече не е избран

3. Сложете отметка на "Create Multi Measure Rests"

Ограничения
Версия 0.9.5 и по-старите не прекъсват автоматично многотактовите
паузи във важни точки, като двойна черта, арматура, репетиционни
маркери. Това вече е оправено в последните версии на MuseScore. Като
временно решение за предишни версии виж глава "Прекъсване на
многотактови паузи" в Работа с тактове.

Опцията Стил автоматично създава многотактова пауза през цялата
партитура. Затова е препоръчително първо да въведете всички ноти и
тогава да включите многотактовите паузи.

Повторение
Началото и края на обикновени повторения може да се зададе с
подходящи тактови черти. Инструкции за първо и второ повторение виж
Волта.

Възпроизвеждане
За да прослушвате и повторенията, убедете се, че бутона "Play Repeats"

 в лентата с инструменти е натиснат. По същия начин можете да
изключите повторенията при възпроизвеждане.

На последния такт от повторение можете да зададете свойството "Repeat
Count" за да дефинирате броя повторения.

Символи за повторения и Текст
Означения, свързани с повторения се намират в палитра повторения.

http:##musescore.org#bg#ръководство#работа-с-тактове
http:##musescore.org#bg#ръководство#тактови-черти
http:##musescore.org#bg#ръководство#волта
http:##musescore.org#bg#ръководство#работа-с-тактове
http:##musescore.org#bg#ръководство#палитра
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За да добавите обект от палитра Повторения, влачете го върху (не над)
такта, в който го искате. Обекта после се показва над този такт в
партитурата.

Прескачане
Прескачанията се състоят основно от три части:

• Отиди на означение

• свири до означение

• продължи от означение

Означенията са имена, които давате на определени места в такта. Две
означения ("начало", "край") обозначават началото и края на
партитурата и не е необходимо да се добавят изрично.

Примери:

На обозначението Da Capo възпроизвеждането прескача в началото и
свири цялата партитура отново (до означението край).

На обозначението Da Capo al Fine възпроизвеждането прескача в
началото и свири партитурата до означението Fine .

Dal Segno al Fine (или D.S. al Fine) прескача до означение Segno и после
възпроизвежда до означение Fine

Dal Segno al Coda прескача до означение Segno и после възпроизвежда
до първото Coda означение. Възпроизвеждането продължава на
следващото Coda означение. Свойствата на прескачането може да се
нагласи чрез дясно копче върху D.S. al Coda означение.

Виж още: Волта

Връзки
• Video tutorial: Codas

http:##musescore.org#bg#ръководство#волта
http:##www.youtube.com#watch?v=04xta6irzgg
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Легато
Легато е крива между две и повече ноти, указваща че нотите се свирят
слято. Ако искате да свържете два еднакви тона, вижте Лигатура

Първи метод
1. Излезте от режим въвеждане на ноти и изберете първата нота:

2. S създава легато:

3. Shift⇑+→ мести крайната точка към следващата нота:

4. X обръща посоката на легатото:

5. СEscape се излиза от Режима на редактиране на Легато:

Втори метод
1. Излезте от режим въвеждане на ноти и изберете първата нота

2. Ctrl-избор (resp. ⌘-избор за Mac) или Shift⇑-избира последната нота

3. hit S

Трети метод
1. Докато сте в режим въвеждане на ноти въведете първата нота от

легато групата.

2. Натиснете S за започване на легато група.

3. Въведете останалите ноти в групата.

4. Натиснете S за да завършите легатото.

http:##musescore.org#bg#ръководство#лигатура
http:##musescore.org#bg#ръководство#въвеждане-на-ноти
http:##musescore.org#bg#ръководство#въвеждане-на-ноти
http:##musescore.org#bg#ръководство#въвеждане-на-ноти
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Нагласяне
Ръкохватките (показани на изображенията в стъпки 2-4 горе) могат да се
нагласят с мишката. Външните ръкохватки определят началната и
крайна позиция на легатото. Вътрешните нагласят контура.

Легатото може да заема няколко системи и страници. Началото и края
са захванати за нота, акорд или пауза. Ако нотите са разместени поради
промени в оформлението, разпъването или стила, легатото също се
променя и напасва.

Този пример показва легато простиращо се от ключ фа до ключ сол.
Чрез мишката изберете първата нота от легатото, задръжте Ctrl (респ. ⌘
на Mac) и изберете последната нота, натиснете S за да добавите легато.

Забележка: Невъзможно е да се променят крайните захващащи точки с
мишката. Използвайте ShiftuArr; + ← или →, за да нагласите крайните
точки.

Пунктир
Легато с пунктирана линия се използват понякога в песни, където
наличието на легато се изменя между строфите. Пунктираното легато
също показва редакторско предложение (за разлика от оригиналната
идея на композитора). За да промените съществуващо легато в
пунктирано, цъкнете с десен бутон върху легато и изберете Slur
Properties.... От прозореца Slur Properties изберете дали да е с плътна или
пунктирана линия.

Виж още: Лигатура, Редактиране, Въвеждане на ноти.

Attachment Размер
slur_b2t.png 12.16 KB

Лигатура
Лигатурата е крива между две ноти с еднакъв тон. Ако искате да
създадете крива, обхващаща няколко тона, вижте Легато.

Първи метод

http:##musescore.org#bg#ръководство#лигатура
http:##musescore.org#bg#ръководство#редактиране
http:##musescore.org#bg#ръководство#въвеждане-на-ноти
http:##musescore.org#sites#musescore.org#files#slur_b2t.png
http:##musescore.org#bg#ръководство#легато
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Изберете първата нота:

+ създава лигатура:

Втори метод
За да създадете лигатура в режим въвеждане на ноти натиснете + след
първата нота.

Размер
Размерните знаци са налични в основната палитра в страничната
лента. Можете да влачите символи върху партитурата (виж палитра за
обща информация относно работа с палитри в MuseScore).

Ако ви трябва размер, който липсва в палитрата, отидете в Create → Time...
за да създадете свой. Можете да редактирате горните и долните
стойности в панел Create Time Signature.

В повечето случаи ще ви се наложи да редактирате първата цифра в
числителя. Допълнителните цифри в числителя са за additive meters,
които съдържат няколко числителя разделени с плюс.

http:##musescore.org#bg#ръководство#въвеждане-на-ноти
http:##musescore.org#bg#ръководство#палитра
http:##en.wikipedia.org#wiki#time_signature#additive_meters
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Ауфтакт
Има случаи, когато действителното времетраене на такт е различно от
зададеното от размера. Ауфтактовете са такъв пример. За да промените
действителната продължителност на такта, без да променяте размера,
вижте раздел Свойства в работа с тактове.

Тремоло
Тремолото е бързо повторение на една нота или бързо сменяне между
две или повече ноти. Указано е чрез пресечна чертичка през опашките
на нотите. Ако тремолото е между две или повече ноти, чертичките се
изчертават между тях.

Палитра тремоло съдържа отделни символи за една нота (пресечените)
и за две ноти (без пресечена линийка).

При тремоло с две ноти, всяка нота има продължителността на цялото
тремоло. За да въведете тремоло с продължителност половин нота
(minim), първо въведете две нормални четвъртини (crotchets). След като
влачите тремоло символ към първата нота, автоматично се удвояват
продължителностите на двете ноти на половини.

Триоли
Триолите се използват за делене на нотите на времена, различни от
тези дадени в размера. Например триоли осмини (quavers) в такт 4/4
разделя четвъртина нота (crotchet) на три, вместо на две.

Инструкции
За да създадете триола първо изберете нота, указваща пълната
продължителност на групата триоли. Например група осмини триоли
имат продължителността на една четвъртина.

От основното меню изберете Notes → Tuplets → Triplet. Това създава триола,
разделяйки пълното времетраене на три равни части,

http:##musescore.org#bg#ръководство#работа-с-тактове
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които после могат да бъдат редактирани.

Режим въвеждане на ноти
Въвеждането на триоли работи малко по-различно в режим въвеждане
на ноти спрямо горния метод. Във версия 0.9.5 или по-нова трябва да
изберете първо времетраенето и после да поставите тоновете. Долу
стъпка по стъпка е указано как се въвеждат триоли осмини.

1. Сменете на режим въвеждане на ноти с натискане на N

2. Уверете се, че курсорът е на точното място, откъдето искате да
започнете (използвайте стрелките наляво и надясно ако е
необходимо)

3. Изберете продължителност на триолата от лентата с инструменти.
Например цъкнете четвъртина нота (или натиснете 5 на
клавиатурата).

4. От главното меню изберете Notes → Tuplets → Triplet, или цъкнете Ctrl+3

(Mac: ⌘+3)

5. Забележете, че осмина продължителност е избрана автоматично.
Цъкайте в петолинието за да добавите тонове

Свойства
За да промените визуализацията на триолите, цъкнете дясно копче на
цифрата и изберете Tuplet Properties....

Числената секция на диалоговия прозорец позволява да показва едно
число или отношение на две числа или никакво число.

В раздела скоби "bracket" и "nothing" позволява да укажете дали да се
показва или скрива скобата. Опцията "auto bracket" скрива скобата за
оребрени ноти и я показва когато няма ребра.

Външни препратки

http:##musescore.org#bg#ръководство#въвеждане-на-ноти
http:##musescore.org#bg#ръководство#въвеждане-на-ноти
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• Tuplet в Wikipedia

• Как да създадем триоли в MuseScore [video]

Гласове
Гласовете ви позволяват да имате ноти на едно петолиние, които
започват от едно и също време, но имат различна продължителност.
Гласовете понякога се наричат "слоеве" в други нотиращи програми.

Инструкции
1. Първо въведете горния глас (всички обърнати нагоре ноти). Докато

въвеждате, някои ноти може да сочат надолу. Няма нужда да се
притеснявате за посоката на опашките, те ще се обърнат
автоматично, когато добавите втори глас.

2. Ако използвате компютърна или MIDI клавиатура за въвеждане на
ноти (вместо мишката), използвайте стрелка Наляво за да преместите
курсора назад до началото.

3. Цъкнете бутон "Voice 2" .

4. Въведете всички ноти от долния глас (обърнатите надолу ноти).
Като сте готови трябва да изглежда така:

Кога да използваме гласове
• Ако искате нотите да сочат в различни посоки в акорд на едно

петолиние

• Ако ви трябват ноти с различно времетраене, на едно петолиние,
изсвирени едновременно

Скрити паузи
За да скриете пауза, цъкнете я с дясно копче и изберете Set Invisible. Ако
Display → Show Invisible е маркирано, тогава паузата ще се показва в сиво
на екрана. Скритата пауза не се отпечатва.

http:##en.wikipedia.org#wiki#tuplet
http:##musescore.org#en#handbook#tuplet
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Волта
Волта скобите или тези за първо и второ повторение се използват за
означаване на различен завършек при повторение.

За да поставите волта-скоба в партитурата, влачете скобата от палитра
Линии.

Скобата може да обхване повече от един такт. Цъкнете два пъти върху
скобата, за да влезете в режим редактиране и после местете
ръкохватките чрез:

• един такт на дясно Shift+Right

• един такт на ляво Shift+Left

Тези команди местят "логическото" начало или край на скобата, което
определя възпроизвеждането в MuseScore и положението й над система
петолиния. Местенето на ръкохватките със стрелките или използвайки
мишката, позволява фино нагласяне, но не променя начина на
възпроизвеждане на повторението.

Ако местите ръкохватките ще видите пунктиране линия, свързваща
логическата позиция с реалната

Текст
Можете да промените текста, както и други свойства на волта скоба от
диалоговия прозорец Line Properties. Щракнете с дясно копче скобата и
изберете Line Properties.... Фигурата долу показва текст "1.-5."

http:##musescore.org#bg#ръководство#линии
http:##musescore.org#bg#ръководство#линии
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Можете също да цъкнете с дясно копче на Волта, за да изведете
прозорец със свойствата. Оттук можете да промените както показвания
текст (по същия начин както в прозореца Line Properties по-горе), така и
списъкът с повторения (Repeat List). Ако искате една Волта да се
възпроизвежда само на някои повторения, а друга на други повторения,
въведете броя повторения в разделен със запетаи списък. В примера
по-долу, тази волта ще се възпроизвежда при повторение 1, 2, 4, 5 и 7.
Друга волта ще има друг завършек, като 3, 6 и вероятно други по-високи
номера като 8, 9 и т.н.

Възпроизвеждане
Понякога повторение се възпроизвежда повече от два пъти. В примера
горе текстът във волтата показва, че тактът трябва да се изсвири пет
пъти преди да продължи. Ако искате да промените броя на
повторенията, които MuseScore ще възпроизведе, отидете в такта,
съдържащ тактова черта за повторение и променете броя от Repeat
Count (виж Работа с тактове за подробности).

Във версия 0.9.4 или по-стара, можете да поставяте волта само на
най-горното петолиние в много-инструментална партитура. В противен
случай може да имате проблеми, като срив на MuseScore, когато
добавяте инструменти (виж доклада за грешки) или преместване на
позицията на скобата при презареждане на партитурата.

Външни препратки
• Screencast: Add alternative repeats with MuseScore 0.9.5

http:##musescore.org#bg#ръководство#работа-с-тактове
http:##www.musescore.org#en#node#1257
http:##www.youtube.com#watch?v=jwizibuf_j8
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глава 4

Звук и възпроизвеждане

MuseScore има вградени възможности за "Звук и възпроизвеждане".
Тази глава покрива управлението на възпроизвеждането, както и начини
да разширите звуковите възможности на инструментите над тези на
вграденото пиано.

Режим възпроизвеждане
MuseScore има вграден секвенсер и синтезатор за възпроизвеждане на
партитурата ви.

Натискайки бутон Play  влизате в режим Play mode. В Play mode са
налични следните команди:

• Връщане към предния акорд Left

• Към следващия акорд Right

• Към предишен такт Ctrl+Left

• Към следващ такт Ctrl+Right

• Превъртане в началото на партитурата Home

• Показване на панела за възпроизвеждане F11

Натиснете повторно бутона play за да спрете и излезете от Play mode.

MuseScore започва възпроизвеждането от там където е спряло преди
това. Ако изберете нота, тогава MuseScore започва от избраната нота. В
лентата с инструменти също има бутон за връщане в началото на
партитурата.

За възпроизвеждане и на повторенията, активирайте бутона 
Включи/Изключи повторенията.
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Панел възпроизвеждане
Панелът за възпроизвеждане предлага повече контрол над
възпроизвеждането, включително темпо, стартова позиция и общо ниво
на звука. Панела се отваря от меню Display → Play Panel.

Attachment Размер
play-repeats.png 182 байта

Темпо
Темпото на възпроизвеждане може да се променя от панела за
възпроизвеждане или чрез текст в партитурата.

Панел възпроизвеждане
• Показване на панела за възпроизвеждане: Display → Play Panel

• Промяна на Ударите в минута (bpm) чрез Темпо (Tmp) плъзгача

Темпо текст
• Изберете нота, за да укажете къде да бъде създаден текста с

темпото

• От основното меню: Create → Text... → Tempo...

• Цъкнете OK, за да завършите

Съществуващо темпо може да се промени, чрез двойно цъкане върху
текста, за да влезете в режим редактиране. Може да използвате
Текстовите символи, за да добавите четвъртина или друга нота или знак
за метроном.

Ударите в минута (BPM) от съществуващ темпо текст могат да бъдат
нагласени, чрез дясно цъкване върху текста и избиране на Tempo
Properties...

Забележка: Възпроизвеждането на написаното темпо може да бъде 
по-бързо или по-бавно от зададеното, ако настройките в панела за

http:##musescore.org#sites#musescore.org#files#play-repeats_1.png
http:##musescore.org#bg#ръководство#редактиране-на-текст
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възпроизвеждане не са зададени на 100 процента.

Промяна и настройка на звука

Смесител
Смесителят ви позволява да променяте звука на инструментите,
настройка на нивото, панорама, реверберация и хорус за всяко
петолиние. От главното меню изберете Display → Mixer, за да се покаже
смесителя.

Заглушаване и Соло
Сложете отметка на Mute за бързо заглушаване на определени
петолиния. Ако сложите отметка на Solo заглушавате всички петолиния,
с изключение на тези, маркирано като "соло".

Въртящи бутони
За да завъртите копче по часовниковата стрелка, цъкнете и провлачете с
мишката нагоре.За да завъртите копче обратно на часовниковата
стрелка, цъкнете и провлачете с мишката надолу.

Звук
Падащото меню Звук показва списък с поддържаните инструменти от
зададения SoundFont. Тази възможност липсва във версия 0.9.4 или
по-стара за Windows, но е налична във версия 0.9.5.

Промяна на инструмент
Въпреки че можете да променяте звука на инструментите, имената и
транспозицията на петолинията отделно, версия 0.9.6 и по-нова ви
позволява да настроите всички тези свойства наведнъж.

1. Цъкнете с дясно копче върху празна част от такт и изберете Staff
Properties...

2. Цъкнете Change Instrument

3. Изберете нов инструмент и цъкнете OK, за да се върнете в диалога
Staff Properties

4. Цъкнете OK пак, за да се върнете в партитурата

Промяна по средата на партитурата

http:##musescore.org#de#handbuch#soundfont
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В MuseScore някои инструменти могат да си променят звука по средата
на произведението. Например струнните могат да минат на пицикато
или тремоло, а тромпетът може да премине към заглушаване.
Следващите инструкции дават за пример заглушен тромпет, но същия
принцип се прилага за пицикато или тремоло при струнните.

1. Изберете първата нота от заглушената част

2. От главното меню изберете Create → Text → Staff Text

3. Напишете Mute (или еквивалентна индикация, като Con Sordino). До
този момент текстът е за хора и не влияе на възпроизвеждането в
MuseScore

4. Цъкнете с дясно копче на текста и изберете Staff Text Properties...

5. В диалоговия прозорец маркирайте Channel

6. Изберете mute

7. Цъкнете OK, за да се върнете в партитурата

Всяка нота след добавения текст вече звучи заглушена. За да върнете
звука към незаглушен, следвайте същата процедура, но напишете Open в
стъпка 3 и изберете normal в стъпка 6.
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глава 5

Текст

Предишната глава обхващаше текст, влияещ на темпото на
възпроизвеждане, но има много видове текст налични в MuseScore:
Текстове на песни, Имена на акорди, за динамика, Пръстовки, заглавия,
плюс много други. Всички са налични от основното меню от Create → Text.

За кратък обикновен текст използвайте текст за система или петолиние.
Разликата е дали искате да го приложите към цяла система или само
едно петолиние.

Редактиране на текст
Цъкнете два пъти на текст, за да влезете в режим редактиране:

В режим редактиране са налични следните команди:

• Ctrl+B (Mac: ⌘+B) включва удебеляване

• Ctrl+I (Mac: ⌘+I) включва курсив

• Ctrl+U (Mac: ⌘+U) включва подчертаване

• преместване на курсора: Home End Left Right

• Backspace изтрива символ от ляво на курсора

• Delete изтрива символ от дясно на курсора

• Return започва нов ред

• F2 Показва палитра текст. Текстовата палитра може да се използва
за въвеждане на специални символи.

http:##musescore.org#bg#ръководство#темпо
http:##musescore.org#bg#ръководство#темпо
http:##musescore.org#bg#ръководство#текстове-на-песни
http:##musescore.org#bg#ръководство#имена-на-акорди
http:##musescore.org#bg#ръководство#пръстовки
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Палитра текст
Можете да използвате Текстовата палитра, за да вмъквате специални
символи, като четвъртина нота, дроби и др. В лентата с инструменти
цъкнете иконата с клавиатура , за да отворите текстовата палитра.

Виж още: Имена на акорди, Текстове на песни, Рамки, Редактиране

Стил на текста
Всеки текст има основен стил. Например заглавния текст е центриран и
е с по-голям размер, Композитор е по-малък и подравнен в дясно. За да
редактирате стила отидете на Style → Edit Text Style....

По време на редактиране на текст можете да правите промени на
оформлението, за да се различава от основните. За подробности виж
"Форматиране на съществуващ текст" по-долу.

Свойства на текста:
• Font: Име на шрифта, като "Times New Roman" или "Arial"

• Size: Размер на шрифта в пунктове

• Italic, Bold, Underline: свойства на шрифта (курсив, удебеляване,
подчертаване)

• Anchor: страница, време, глава на нота, система, петолиние

• Alignment: хоризонтално подравняване: ляво, дясно, център;
вертикално подравняване: отгоре, отдолу, център

• Offset: отместване от нормалната котвена позиция

• Offset Type: Вид на отместването - mm, разстояние или процент от
големината на страницата

Типове текст:
• Заглавие, Подзаглавие, Композитор, Поет: закачени за

страницата

• Fingering: Пръстовките се закачат за главите на нотите.

http:##musescore.org#bg#ръководство#имена-на-акорди
http:##musescore.org#bg#ръководство#текстове-на-песни
http:##musescore.org#bg#ръководство#рамки
http:##musescore.org#bg#ръководство#редактиране
http:##musescore.org#bg#ръководство#редактиране-на-текст
http:##musescore.org#en#handbook#fingering
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• Lyrics: Текстовете на песните са позиционирани по време.

• Имена на акорди: Имената на акордите също са позиционирани по
време.

• Система: Прилага се на всички петолиния в система.* Позиционира
се по време.

• Петолиние: Прилага се на едно петолиние в система.* Позиционира
се по време.

* Различието в текста на едно петолиние и на цяла система има
значение в ансамбълните партитури. Системния текст ще излезе на
всички партии. Текста на петолинието ще излезе само на партията, към
която е прикачен.

Форматиране на съществуващ текст
В MuseScore 1.0 и по-стари, промените на текстовото оформление се
прилагат на нов текст, но не променят съществуващия. Все пак можете
да промените форматирането на съществуващия текст, като цъкнете с
дясно копче и избирайки "Text properties". За да приложите промените
към целия текст от същия вид, сложете отметка на "apply to all elements
of the same type".

Имена на акорди
Имената на акордите могат да бъдат въведени, като първо изберете
нота и натиснете Ctrl+K. Това създава текстов обект с името на акорда.

• Натиснете Интервал за да минете на следващия акорд.

• Shift+Интервал премества към предишния акорд.

• Ctrl+Интервал вмъква интервал в името на акорда.

• Натиснете Tab за да минете на следващия такт (версия 1.1 и по-нова).

• Shift+Tab връща към предишния такт (версия 1.1 и по-нова)

Имената на акордите могат да бъдат редактирани като нормален текст.
За да добавите диез напишете #, а за да добавите бемол напишете b.
Тези символи автоматично ще се преобразуват в правилните символи за
диез и бемол, когато преминете на следващия акорд.

MuseJazz шрифт
Ако предпочитате по-ръкописен вид на имената на акордите във вашата
партитура, тогава версия 0.9.5 и по-новите включва опция, наречена
"MuseJazz".

http:##musescore.org#en#handbook#lyrics
http:##musescore.org#bg#ръководство#имена-на-акорди
http:##musescore.org#bg#ръководство#редактиране-на-текст
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1. От главното меню изберете Style → Load Style...

2. Отидете до папка styles ако е нужно

3. Изберете MuseJazz.mss

Това ще настрои партитурата да използва "MuseJazz" за повечето текст,
включително имената на акордите. Ако предпочитате да използвате
"MuseJazz" само за имената на акордите, тогава следвайте инструкциите
по-долу.

В 1.0 и по-стара или ако искате да използвате "MuseJazz" само за
имената на акордите, следвайте процедурата:

1. От основното меню изберете Style → Edit Style...

2. От лявото поле изберете Chord names

3. В дясното поле сменете текста chords.xml с jazzchords.xml

В 1.1 и по-нова, MuseScore осигурява няколко нови варианта за
оформление на имената на акордите в допълнение на jazzchords.xml,
които могат да се изберат чрез описаната горе процедура. Ето и
наличните оформления:

• cchords_muse.xml (по подразбиране, когато се използва MuseJazz.mss):

• cchords_nrb.xml:

• cchords_rb.xml:

• cchords_sym.xml:

Attachment Размер
cchords_muse.png 11.77 KB
cchords_nrb.png 12.55 KB
cchords_rb.png 11.28 KB
cchords_sym.png 11 KB

Пръстовки

http:##musescore.org#sites#musescore.org#files#cchords_muse_1.png
http:##musescore.org#sites#musescore.org#files#cchords_nrb_1.png
http:##musescore.org#sites#musescore.org#files#cchords_rb_1.png
http:##musescore.org#sites#musescore.org#files#cchords_sym_1.png
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Пръстовките се добавят, като се влачи символ от палитра пръстовки
към главата на нота от партитурата. Когато е избрана първо нота,
символ за пръстовка може да се добави с двойно цъкане. Пръстовките са
нормален текст, който може да бъде редактиран като всеки друг текст.

Текстове на песни
1. Първо въведете нотите

2. Изберете първата нота

3. От главното меню изберете Create → Text → Lyrics и напишете
сричката за първата нота

4. Натиснете Интервал след края на думата, за да отидете на
следващата нота

5. Натиснете тире - в края на сричка, за да отидете на следващата
сричка. Сричките са свързани с тире

6. Shift⇑+Интервал връща на предната сричка

7. Enter (Mac: Return) премества надолу към следващия ред текст

Сричките могат да бъдат удължени с долна черта:

Въведени чрез: soul, _ _ _ To Esc.

http:##musescore.org#bg#ръководство#редактиране-на-текст
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Легато на текста, за свързване на две срички под една нота

В текстовата лента с инструменти цъкнете иконката с клавиатура ,
или натиснете F2 за да отворите палитрата със символи.

Специални символи
Текстовете могат да бъдат редактирани като обикновен текст, с
изключение на някои символи. Ако искате да добавите интервал, тире
или долна черта към една сричка, тогава използвайте следната
комбинация.

• Ctrl+Интервал (Mac: ⌥+Интервал) вмъква ■■■■■■■■ в текста

• Ctrl+- (Mac: ⌥+-) вмъква тире (-) в текста

• Само за Mac: ⌥+_ вмъква долна черта (_) в текста

Виж още: Текст, Имена на акорди.

Връзки
• Video tutorial: Lyrics, Copying & Dynamics

Attachment Размер
lyric slur.jpg 4.25 KB
Keyboardico.png 967 байта

http:##musescore.org#bg#ръководство#редактиране-на-текст
http:##musescore.org#bg#ръководство#текст
http:##musescore.org#bg#ръководство#имена-на-акорди
http:##www.youtube.com#watch?v=e55-ynhsk-s
http:##musescore.org#sites#musescore.org#files#lyric-slur.jpg
http:##musescore.org#sites#musescore.org#files#keyboardico.png


50

глава 6

Форматиране

Разделители
Разделителите на страница или разделители на редове (системни
разделители) се поставят, чрез влачене на съответния символ от
палитра разделители към празно място от такт в партитурата.
Разделянето става след маркирания такт. Зеления разделителен символ
е видим само на екрана, но не се разпечатва.

Системни разделители са необходими понякога (особено при стихови
песни или химнове). Например ако искате три времена на един ред и
един ауфтакт на друг ред, трябва да създадете два такта с по-кратка
продължителност. За повече подробности виж Работа с тактове, раздел
"Времетраене", "Неправилни" и последния раздел.

Разделителите на редове се използват за увеличаване на
разстоянието между две съседни петолиния. Влачете такъв разделител
върху такт, над който трябва повече вертикално пространство. Цъкнете
два пъти върху разделителя и дърпайте ръкохватката с мишката, за да
нагласите височината му.

Ако искате да нагласите разстоянието между петолинията глобално за
цялата партитура, използвайте настройките на стила. Разделителите са
за локално нагласяне.

Рамки
Рамките осигуряват празно пространство извън тактовете. Те могат да
съдържат текст или картинки. MuseScore има два вида рамки:

http:##musescore.org#bg#ръководство#работа-с-тактове
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Хоризонтални

Хоризонталните рамки прекъсват система. Ширината им се наглася,
а височината съответства на височината на системата.
Хоризонталните рамки могат да се използват за разделяне на coda.

Вертикални

Вертикалните рамки осигуряват празно пространство между или над
системи. Височината им се наглася, а ширината съответства на
ширината на системата. Вертикалните рамки се използват за
поставяне на заглавие, подзаглавие или композитор. Ако създадете
заглавие, вертикална рамка се поставя преди първия такт
автоматично, ако вече няма такава там.

Създаване на рамка
Първо изберете такт. Командата за вмъкване на рамка е в меню Create →
Measures . Рамката се вмъква преди избрания такт.

Изтриване на рамка
Изберете рамката и натиснете Del.

Редактиране на рамка
Цъкнете два пъти рамката, за да влезете в режим редактиране. Появява
се ръкохватка, с която може да се променя размера на рамката.

Заглавна рамка в режим редактиране:

http:##musescore.org#bg#ръководство#редактиране
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Изображения
Можете да използате изображения за поясняване на партитури или за
добавяне на символи, които не са налични в стандартните палитри.

За да добавите изображение влачете файл с картинка в партитурата.
MuseScore поддържа PNG и JPEG файлове и прости SVG файлове.
MuseScore не поддържа SVG сенки, размазване, изрязване или маски.
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глава 7

Разширени теми

Групиране на ноти между петолиния
В партитури за пиано често се налага да се използват двете петолиния
(ключ сол и ключ фа), за записване на музикална фраза.
Въвеждането в MuseScore става:

Първо въведете нотите на едно петолиние:

Ctrl+Shift+Down мести избраната нота или акорд в следващото петолиние
(Mac: ⌘+Shift+Down.)

Виж още: Тактови черти за свързване на тактовите черти (напр. grand
staff).

Добавки

http:##musescore.org#bg#ръководство#тактови-черти
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Добавките са малка част от код, която добавя определена възможност
към MuseScore. Вмъквайки добавка, ново меню ще се появи в меню
Plugins в MuseScore, което ще извърши определено действие в
партитурата или на чест от нея. Добавките позволяват на потребители с
минимални знания по програмиране да добавят функционалност към
софтуера. За да създадете добавка, вижте документацията.

Някои добавки идват с MuseScore. Можете да намерите още в
хранилището с добавки.

Инсталиране
Имайте предвид, че някои добавки може да изискват инсталиране на
други компоненти (шрифт...), за да работят. Прочетете документацията
за повече информация.

Повечето добавки идват като zip файлове, така че изтеглете .zip файла и
го разархивирайте в някоя от долуспоменатите директории.
Накои идват като .js файл, изтеглете го и го поставете в някоя от тези
директории.
Някои са като .txt файл, изтеглете го и го поставете в някоя от тези
директории и преименувайте разширението на файла на .js

Windows
MuseScore търси добавки в %ProgramFiles%\MuseScore\Plugins (респ.
%ProgramFiles(x86)%\MuseScore\Plugins за 64-битови версии) и в
%LOCALAPPDATA%\MusE\MuseScore\plugins на Vista и Седем или
C:\Documents and Settings\USERNAME\Local Settings\Application

Data\MusE\MuseScore\plugins на Windows XP.
Изтеглете zip файла на добавката и го разархивирайте в една от тези
директории.

MacOS X
При MacOS X, MuseScore търси добавки в MuseScore bundle
/Applications/MuseScore.app/Contents/Resources/plugins и в
~/Library/Application Support/MusE/MuseScore/plugins. За да можете
да местите файлове в app bundle, цъкнете с дясно копче на
MuseScore.app и изберете "Show package contents" за да се покаже
директорията Contents. Използвайте Contents/Resources/plugins а не
Contents/plugins.

Linux
На Linux, MuseScore търси добавки в /usr/share/mscore-1.2/plugins и
в ~/.local/share/data/MusE/MuseScore/plugins.

Във всеки от горните случаи, рестартирайте MuseScore, за да се заредят
новите добавки.
В MuseScore 2.0+ добавките трябва да се активират от Menu -> Edit ->
Preferences -> Plugins, последвано от още един рестарт.

http:##musescore.org#en#plugin-development
http:##musescore.org#en#plugins
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Версии преди MuseScore 2.0 трябва да има отворена партитура, за да се
активира меню Добавки.

Добавки, инсталирани по подразбиране

ABC import
Тази добавка използва уеб услуга (http:##abc2xml.appspot.com#), за да
отвори ABC файл в MuseScore. Поддържа ABC 1.6. ABC фалът се праща
към уеб услугата, която връща MusicXML файл. После добавката показва
партитурата като нова партитура.
Подобрена версия има в ханилището с добавки.

Break Every X Measures
This plugin enters line breaks in the interval selected by you on the selected
measures or, if no measures are selected, the entire score.

Break 4
This is an older version of the Break Every X Measures plugin and was part
of MuseScore 0.9.5. It may still be available in your installation.
It inserts line breaks every 4 measures on the entire score.

Chord chart
Тази добавка създава нова партитура със всички имена на акордите,
поддържани от Джаз формата на MuseScore. От версия 1.2 се нарича
"Create Chord Chart" и се намира в "Plugins -> Lead Sheet" и позволява
избор на стила на акорда.
Подобрена версия има в ханилището с добавки.

Color notes
Тази добавка оцветява главите на всички ноти във всички петолиния и
гласове според конвенцията на BoomWhackers. Всеки тон има различен
цвят. C и C# имат различен цвят. C# и Db са с еднакъв цвят.
За да оцветите всички ноти в черно, цъкнете с дясно копче глава на нота
-> Select -> All similar elements. Отново дясно копче на нотата -> Color ->
Pick black. Може също да използвате "Remove Notes Color" добавка за
това.

Create scores
Тази добавка създава нова пиано партитура с 4 четвъртини C D E F.
Добър старт за научаване как се създава нова партитура и как се
добавят ноти.

Font Test
This plugin is identical to the Note Names plugin, but uses a different font. It
is not part of MuseScore anymore, but was part of 1.0 and as such might still
be available in your installation.

Note names

http:##abc2xml.appspot.com#
http:##en.wikipedia.org#wiki#abc_notation
http:##musescore.org#project#abc
http:##musescore.org#project#abc
http:##musescore.org#en#project#blacknotes
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Тази добавка показва английските наименования на горната нота на
акорд от глас 1 близо до главата й.
Подобрена версия има в ханилището с добавки.

Remove Notes
This plugin removes the given (bottom, middle, or top) note of all 3-note
chords in voice 1 of the top staff.

Save Online ...
This Plugin is not in the Plugins menu, but in the File Menu (File → Save
Online...). It is a plugin nonetheless and is used to send your Score to
MuseScore.com, see Share scores online for documentation.

Temperament Tuning
This plugin was part of MuseScore 0.9.6 and is the newer version of the
Tuning plugin (see below). It later got moved to the plugin repository, so
check its documentation there.

Test
Тази добавка е само тест и показва диалогов прозорец "Hello MuseScore".
Представлява добра основа за усвояване на разработката на добавки.
Вече не е част от MuseScore, беше в 1.0 и по-стари и затова все още
може да е налична във вашата инсталация.

Tuning
This plugin was part of MuseScore 0.9.5 and is the older version of the
Temperament Tuning plugin (see above). It may still be available in your
installation.
It applies a user defined tuning to all notes of all chords of voices 1-3 (but
not voice 4!) of all staves.

Извличане на партии
Ако сте писали пълна ансамбълна партитура, MuseScore може да
създаде партия (щим), за всеки музикант в ансамбъла.

В текущата версия на MuseScore, процесът на извличане на щим от
пълна партитура включва две основни стъпки:

1. Задаване кои инструменти са включени във всяка партия
("Определяне на партиите")

2. Действително създаване на партия

Определяне на партиите
Можете да определите партиите във всеки един момент след създаване 
на нова партитура. Нужно е само веднъж за всяка партитура, но разбира

http:##musescore.org#project#abc
http:##musescore.org#en#handbook#share-scores-online
http:##musescore.org#project#scales
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се винаги можете да направите промени ако е нужно. Следващите
инструкции използват за пример струнен квартет, но същият принцип се
прилага за всеки друг ансамбъл.

От главното меню изберете File → Parts...

В прозорецът Партии цъкнете New, за да създадете "дефиниция на
партията"

В десния панел въведете име за файлът "File Name" и за партията
"Part Title"

Име на файла

Името използвано при запис на щимът на компютъра
(задължително)

Заглавие на партията

Текстът отпечатан на първата страница на щима в горния ляв
ъгъл (по избор)

4. Изберете инструмент, който да излиза в щима, като маркирате
съответната отметка в десния панел. Обикновено ви трябв само един
инструмент за щим, но понякога може да искате партия с повече от
един инструмент (като няколко петолиния с перкусии). MuseScore ви
позволява да изберете колкото искате инструменти за една партия.
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5. Повторете стъпки от две до четири (по-горе) за всяка необходима
партия

6. Веднъж като сте готови, натиснете Close за да напуснете прозорецът
Партии

Вече завършили дефинирането на партии. Няма нужда да го правите
отново, освен ако не добавите или премахнете инструмент към пълната
партитура. В текущите версии на MuseScore не е възможно да разделите
едно петолиние (съдържащо два или повече гласа) на отделни партии.
Затова, всеки инструмент, който искате да се раздели на отделен щим
трябва да има си има отделно петолиние в общата партитура. Това
изиства известен замисъл.

Създаване на партиите
Можете да създадете партии по всяко време, за да видите как
изглеждат, но е необходимо да го направите след като сте завършили
общата партитура или поне като имате вече въведена някаква музика и
искате да видите как ще изглежда щимът:

1. От главното меню изберете File → Parts... за да извикате прозорецът
Партии.

2. В левия панел изберете партия, която искате да създадете и да
прегледате
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3. Натиснете Create Part и нов раздел се добавя към главния прозорец
на MuseScore, съдържащ новосъздаденият щим

Повторете стъпка две и три за всяка партията, която искате да
разгледате или отпечатате. Ако направите промени в общата партитура,
можете да създадете отново щим по всяко време, за да се отразят
промените.

Запазване
В настоящите версии на MuseScore промените в партитурата не са
свързани с вече създадените партии, затова всяка промяна в
партитурата трябва да се направи и в щима или ръчно или като се
създаде отново по описания горе начин. Също така партиите се създават
като още не записан файл, затова всеки току що създаден щим трябва да
бъде записан като отделен файл (чрез File → Save...) или ще бъде загубен
при затваряне на раздела. Обикновено ще искате да го прегледате за
правилно оформление преди да го запазите.
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глава 8

Поддръжка

В тази глава е описано как да търсим помощ относно MuseScore:
най-доброто място да търсите, най-добрия начин да зададете въпрос във
форумите, съвети за докладване на бъгове.

Възстановяване на заводските настройки
Последните версии на MuseScore имат възможност да върнат
първоначалните си настройки или "factory-settings". Понякога това е
поплезно ако настройките ви се повредят. Това не е нормално явление,
затова най-добре се консултирайте във форумите, тъй като вероятно е
там да има решение на проблема, без да е необходимо да връщате
всичко.

Внимание: възстановяването на настройките премахва всички промени
в предпочитанията, палитри или прозорци.

Инструкции за Windows
1. Ако сте отворили MuseScore трябва да я затворите (File → Quit)

2. Натиснете Windows key+R за да отворите Run диалога. (Windows key е
този с логото на Microsoft Windows.)

3. Цъкнете Browse...

4. Търсете mscore.exe на компютъра си. Мястото може да варира
според инсталацията ви, но вероятно е нещо подобно на My
Computer > Local Disk > Program Files > MuseScore > bin >
mscore.exe

5. Цъкнете Open за да излезете от диалоговия прозорец Browse и да се
върнете на Run. Трябва да видите следния текст (или подобен) в
прозореца Run: "C:\Program Files\MuseScore\bin\mscore.exe"

6. Цъкнете след кавичките, добавете интервал, тире и главно F: -F

http:##en.wikipedia.org#wiki#windows_key
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7. Натиснете OK

След няколко секунди MuseScore ще се стартира и всички настройки ще
са върнати към заводските "factory settings".

За напреднали потребители, главния файл с настройки се намира в:

• Windows Vista или по нов:
C:\Users\<USERNAME>\AppData\Roaming\MusE\MuseScore.ini

• Windows XP или по-стар: C:\Documents and
Settings\USERNAME\Application Data\MusE\MuseScore.ini

Останалите настройки (палитри, сесии...) са в:

• Windows Vista или по нов:
C:\Users\<USERNAME>\AppData\Local\MusE\MuseScore\

• Windows XP или по-стар: C:\Documents and
Settings\USERNAME\Local Settings\Application Data\MusE\

Инструкции за Mac OS X
1. Ако MuseScore е стартирана, първо трябва да я затворите (File → Quit)

2. От Open Applications/Utilities/Terminal ще се появи терминален
прозорец

3. Напишете, (или копирайте) следната команда в реда на терминала
(добавете '/' в началото):

/Applications/MuseScore.app/Contents/MacOS/mscore -F

Това ще възстанови всички настройки към първоначалните и ще
стартира веднага MuseScore. Вече може да изключите терминала и да
продължите да използвате MuseScore.

За напреднали потребители, главния файл с настройки се намира в
~/.config/muse.org/MuseScore.ini.
Останалите настройки (палитри, сесии...) са в ~/Library/Application
Support/MusE/MuseScore/

Инструкции за Linux (моля пригодете ги за различен от
Ubuntu Lucid)

1. Ако MuseScore е стартирана, първо трябва да я затворите (File → Quit)

2. От основното меню в Ubuntu изберете Applications → Accessories →
Terminal. Отваря се терминален прозорец

3. Напишете, (или копирайте) следната команда в реда на терминала:

mscore -F
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Това ще възстанови всички настройки към първоначалните и ще
стартира веднага MuseScore. Вече може да изключите терминала и да
продължите да използвате MuseScore.

За напреднали потребители, главния файл с настройки се намира в
~/.config/MusE/MuseScore.ini

Известни несъвместимости
Следния софтуер причинява срив на MuseScore при стартиране:

• Samson USB Microphone, driver name "Samson ASIO Driver",
samsonasiodriver.dll. Още информация

• Digidesign MME Refresh Service. Още информация

Как да докладваме бъгове или да искаме
помощ
Преди да публикувате въпрос за помощ във форума:

• МОЛЯ, потърсете решение в Ръководството.

• Използвайте търсачката на сайта, за да видите дали някой вече не
се е сблъскал с проблема във форума.

• Ако публикувате доклад за грешки, първо опитайте да пресъздадете
проблема с последната версия. Също може да видите историята на
версиите за да проверите дали не е вече оправен.

Когато търсите помощ или докладвате грешки, моля дайте възможно
най-много от следната информация:

• Версията на MuseScore, която използвате (например версия 1.0) или
номер на ревизията, в случай че използвате предварителна версия
(например ревизия 3996)

• Операционната система, на която я използвате (например Windows
Vista, Mac OS 10.6 или Ubuntu 10.10)

• Ако докладвате бъг, моля опишете точните стъпки, водещи до
проблема (къде цъкате, кои клавиши натискате, какво виждате и
т.н.). Ако не можете да възпроизведете проблема в стъпки, вероятно
не си струва да го докладвате, тъй като разработчиците също не биха
могли да го възпроизведат (и решат).

• Описвайте по една грешка в един доклад

http:##musescore.org#en#node#6849
http:##musescore.org#en#node#6529
http:##musescore.org#en#forum
http:##musescore.org#en#handbook
http:##musescore.org#en#search
http:##musescore.org#en#forum
http:##musescore.org#en#download
http:##mscore.svn.sourceforge.net#viewvc#mscore#trunk#mscore#changelog
http:##mscore.svn.sourceforge.net#viewvc#mscore#trunk#mscore#changelog
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• Помнете, че целта на доклада е, не само да покажете грешката, но и
да позволите на другите да я възпроизведат лесно.
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глава 9

Клавишни комбинации

Клавишните комбинации могат да се настроят от Edit → Preferences... →
Shortcuts tab (Mac: MuseScore → Preferences... → Shortcuts tab). Долу е списък с
първоначално зададените настройки.

Навигация
Начало на партитура: Home

Последна страница на партитура: End

Следваща страница: Pg Dn

Предишна страница: Pg Up

Следващ такт: Ctrl+Right (Mac: ⌘+Right)
Предишен такт: Ctrl+Left (Mac: ⌘+Left)

Следваща нота: Right

Предишна нота: Left

Нота надолу (в акорд или на долното петолиние): Alt+Down (В Убунту тази
комбинация превключва виртуалните работни плотове)
Нота нагоре (в акорд или на горното петолиние): Alt+Up (В Убунту тази
комбинация превключва виртуалните работни плотове)

Най-горната нота в акорд: Ctrl+Alt+Up

Най-долната нота в акорд: Ctrl+Alt+Down

Въвеждане на ноти
Започва въвеждане: N
Изход въвеждане: N или Esc

Времетраене
За списък на бързите клавиши за всяко времетраене (като
четвъртина, осмина и т.н.) виж въвеждане на ноти.

http:##musescore.org#bg#ръководство#въвеждане-на-ноти
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Удвояване на продължителността на предишната нота: Q
Съкращаване наполовина продължителността на предишната нота: W

Гласове
Глас 1: Ctrl+I, Ctrl+1 (Mac: TBC)
Глас 2: Ctrl+I, Ctrl+2 (Mac: TBC)
Глас 3: Ctrl+I, Ctrl+3 (Mac: TBC)
Глас 4: Ctrl+I, Ctrl+4 (Mac: TBC)

Тон
Тоновете се въвеждат по буквено наименование или чрез MIDI
клавиатура. Виж Въвеждане на ноти за пълни подробности.

Повтори предишната нота: R

Вдигни с една октава: Ctrl+Up (Mac: ⌘+Up)
Свали с една октава: Ctrl+Down (Mac: ⌘+Down)

Вдигни с половин тон: Up

Свали с половин тон: Down

Добави диез: (недефинирано, поради конфликт с приближаването)
Добави бемол: -

Пауза: 0 (нула)Във версия 0.9.6 и предишни Пауза: Интервал

Интервал
Добави интервал над текущата нота: Alt+[Цифра]
Добави интервал под текущата нота: Shift+[Цифра]

Посока
Обърни посоката (байраче, лигатура, скоби на триоли и т.н.): X
Удвои нотната глава: Shift+X

Артикулация
Връзка: +
Легато: S
Стакато: Shift+.

Кресчендо (hairpin): H
Декресчендо: Shift+H

Добавяне на думи
Предишна сричка: Ctrl+Left

Следваща сричка: Ctrl+Right

Нагоре към предишна строфа: Ctrl+Up (Mac: ⌘+Left)
Надолу към предишна строфа: Ctrl+Down (Mac: ⌘+Right)

За повече бързи клавиши при текстове, виж Текстове на песни

http:##musescore.org#bg#ръководство#гласове
http:##musescore.org#bg#ръководство#въвеждане-на-ноти
http:##musescore.org#bg#freelinking#%d0%92%d1%80%d1%8a%d0%b7%d0%ba%d0%b0
http:##musescore.org#bg#ръководство#легато
http:##musescore.org#bg#ръководство#текстове-на-песни
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Изглед
Навигатор: F12 (Mac: ⌥+⌘+N)
Панел възпроизвеждане: F11 (Mac: ⌥+⌘+P)
Палитри: F9 (Mac: ⌥+⌘+K)
Смесител: F10 (Mac: ⌥+⌘+M)

Лицензирано съгласно Creative Commons Attribution 3.0 лиценз,
2002-2012 Werner Schweer и др.
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